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การใช้โปรแกรมสำเร็จรูปทางสถิติเบื้องต้น (SPSS) 

 
 โปรแกรม SPSS for Windows (Statistical Package for Social Science) เป็นโปรแกรมสำเร็จรูป

ทางสถิติท่ีสามารถสร้างแฟ้มข้อมูลและวิเคราะห์ข้อมูลได้อย่างมีประสิทธิภาพ สามารถวิเคราะห์กับข้อมูลได้ 

หลากหลายประเภทใช้งานได้ง่าย เนื่องจากโปรแกรม SPSS มีรูปแบบไม่ซับซ้อนง่ายต่อการใช้งานสามารถ 

เลือกคำสั่งได้จากเมนูได้ อีกท้ัง DATASET ใน SPSS สร้างข้ึนสามารถเปิดได้กับทุก version 

 

1. การสร้างแฟ้มข้อมูลด้วย SPSS  

  1.1 ส่วนประกอบของ Data Editor 

       Data Editor ประกอบด้วย 2 หน้าจอ โดยหน้าจอแรก คือ Data View เป็นส่วนใช้ป้อนและ

แสดงข้อมูลของตัวแปรต่าง ๆ และหน้าจอที่ 2 คือ Variable View เป็นส่วนใช้กำหนดตัวแปรและรายละเอียด

ต่าง ๆ ทั้งนี้สามารถเลือกเปิดหน้าจอใดหน้าจอหนึ่งของ Data Editor เพ่ือกำหนดให้เป็นหน้าจอทำงานตาม

ต้องการโดยการคลิกที่แถบ Data View หรือ Variable View ซึ่งอยู่มุมล่างด้านซ้ายของ Data Editor 

 
 

หน้าจอ Data View ของ Data Editor มีลักษณะสำคัญ ดังนี้ 

       1. แต่ละแถว คือ ชุดข้อมูล 1 ชุด ค่าที่ปรากฏในแถว 1 แถว ถูกแปลงมาจากแบบสอบถาม 1 ชุด ทั้งนี้

แต่ละหัวแถวมีหมายเลขแถวแสดงลำดับของชุดข้อมูลใน Data Editor 

       2. แต่ละสดมภ์ คือ ตัวแปรหนึ่งตัว 

แถบ Variable 
View 

แถบ Data 
View 
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หน้าจอ Variable View ของ Data Editor ประกอบด้วย 11 สดมภ์ ดังนี้ 

 1. Name ใช้กำหนดชื่อของตัวแปรหรือสัญลักษณแทนตัวแปรนั้น ๆ ความยาวไม่เกิน 8 ตัวอักษร 

 2. Type ใช้กำหนดชนิดของตัวแปร ได้แก่ Numeric เปนขอมูลทีเ่ปนตัวเลขและ String เปนขอมูลที่

เปนตัวอักษร 

 3. Width ใช้กำหนดความกวางของตัวแปรหรือจํานวนอักขระหรืออักษรที่ตองการใหใสไดใน Values 

 4. Decimals ใช้กำหนดจำนวนจุดทศนิยมของแต่ละตัวแปร 

 5. Labels ใช้คําอธิบายตัวแปรหรือชื่อเต็มของตัวแปรนั้น ๆ จะใชในกรณีที่ผูวิจัยกําหนดชื่อตัวแปรใน 

column Name เปนอักษรยอแลวตองการอธิบายหรือขยายความไว เชน Name ระบุเปน ID ใน Labels จะ

ระบุเปนลําดับที ่หรือ Name ระบุเป็น Salary ใน Labels จะระบุเปนรายไดตอเดือน เปนตน 

 6. Values ใช้การกําหนดคาใหกับตัวแปร เชน ตัวแปรเพศ กําหนดให เพศชาย มีคาเทากับ 1 และ

เพศหญิง มีคาเทากับ 2 เปนตน  

 7. Missing ใช้กำหนดค่าสูญหายคาของขอมูลหรือแบบสอบถามที่ไม่สมบูรณ์หรือไม่มีคำตอบ ได้แก่ 

      - No missing values ไม่ได้กำหนดค่าสูญหาย กรณีไม่พิมพ์ข้อมูล โปรแกรมจะให้ค่าเป็นจุด (.) 

ซึ่งหมายถึง System – missing value 

               - Discrete missing values ผู้ใช้เป็นผู้กำหนดรหัสของ missing เอง 

               - Range plus one optimal discrete missing value กรณีท่ีผู้วิจัยกำหนดให้ผู้ตอบข้าม 

หรือไม่ต้องตอบคำถามบางข้อ ให้กำหนดรหัสของคำถามที่ต้องการข้ามไว้อีกรหัสหนึ่ง 

 8. Column ใช้กําหนดความกวางของ Column เฉพาะในหน้าจอ Data View 

 9. Align ใช้กําหนดลักษณะการวางขอมูลวาจะใหอยูชิดซาย ขวา หรือตรงกลาง 

 10. Measure ใช้กำหนดมาตรการวัดข้อมูล ได้แก่ Nominal, Ordinal หรือ Scale 

 11. Role เป็นการแสดงบทบาทของตัวแปร 

 

ตัวอย่างการกำหนดลักษณะตัวแปรในหน้าต่าง Variable View 
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หน้าต่าง Data View 

 
 

1.2 ส่วนของ Output  เป็นหน้าต่างแสดงผลลัพธ์การประมวลผล 

 
 

2. การลงรหัสในแฟ้มข้อมูล 

 การคีย์ข้อมูลจะใชหนาตาง Data view เปนหลัก   

 ขอมูลในแตละแถว หมายถึง ขอมูล 1 ชุด เชน แถวที่ 1, 2, 3, …, n เปนขอมูลของผูตอบคนที่ 1, 2, 

3, …, n ตามลําดับ 

 ขอมูลในแตละ column หมายถึง ขอมูลของตัวแปรแตละตัว หรือขอคําถามแตละขอ 

 วิธีการคีย ์ใหใสรหัสตามคาทีเ่รากําหนดไว้ เชน ตัวแปรเพศ คือ 1 = เพศชาย 2 = เพศหญิง และ  

9 = ไมตอบ ดังนั้นเวลา Key ขอมูลเพศก็จะ Key หมายเลข 1 หรือ 2 หรือ 9 เทานั้น 

 แตใ่นกรณีของ salary ใหใสตัวเลขตามที่ผูตอบแบบสอบถามระบุไดเลย ดังตัวอยางต่อไปนี้ 
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3. การกำหนดตัวแปรจากเครื่องมือที่ใชใ้นการรวบรวมข้อมูล 
 โดยทั่วไปเครื่องมือที่ผู้วิจัยนิยมใช้ในการเก็บรวบรวมข้อมูลมักอยู่ในรูปของแบบสอบถาม แบบบันทึก
การสัมภาษณ์ แบบบันทึกการสังเกต หรือแบบบันทึกผลการทดลอง เป็นต้น ซึ่งเครื่องมือที่ใช้ในการเก็บ
รวบรวมข้อมูลเหล่านี้ ก่อนที่จะนำมาบันทึกข้อมูลลงในโปรแกรม SPSS ผู้วิเคราะห์ข้อมูลจะต้องมีความรู้ 
ความเข้าใจกระบวนการกำหนดตัวแปรที่รวบรวมข้อมูลต่าง ๆ จากเครื่องมือที่ตนใช้เสียก่อน เพ่ือนำรายการ 
ตัวแปรต่าง ๆ ที่กำหนดได้นั้นมาทำการสร้างตารางบันทึกข้อมูลในโปรแกรม SPSS 
 ในขั้นตอนของการกำหนดตัวแปรจากเครื่องมือที่ใช้ในการรวบรวมข้อมูล จะประกอบด้วย 
 1. การสำรวจลักษณะของข้อมูลที่เก็บรวบรวมมาในเบื้องต้น เพ่ือใช้เป็นแนวทางในการกำหนดตัวแปร 
และลักษณะของตัวแปร 
 2. การคัดเลือกตัวแปรที่ใช้ในการวิเคราะห์ข้อมูล เป็นการคัดเลือกตัวแปรเฉพาะที่มีความจำเป็นใน
การวิเคราะห์ข้อมูล ซึ่งในบางครั้งอาจมีการคัดเลือกตัวแปรบางตัวเพื่อนำไปใช้งาน หรือใช้ทุกตัวที่มีอยู่ทั้งหมด 
เพ่ือให้ตอบสนองต่อวัตถุประสงค์ของการวิเคราะห์มากท่ีสุด และใช้เวลาในการบันทึกข้อมูล 
น้อยที่สุด 
 3. การกำหนดรหัสแทนข้อมูลเชิงกลุ่ม (Categories data) โดยส่วนใหญ่นิยมใช้รหัสแทนค่าของข้อมูล 
เช่น  
  เพศชาย แทนด้วยรหัส 1 เพศหญิง แทนด้วยรหัส 2 
  สถานภาพสมรส โสด แทนด้วย 1 แต่งงาน แทนด้วย 2 อ่ืน ๆ แทนด้วย 3 
ทั้งนี้เพ่ือให้เกิดความสะดวกในการบันทึกข้อมูล และเพ่ือลดความผิดพลาดที่เกิดจากการบันทึกข้อมูล 
 4. การจัดทำสมุดคู่มือรายชื่อตัวแปร และคู่มือการลงรหัสข้อมูล เป็นการจัดทำคู่มือแสดงรายชื่อตัว
แปรทั้งหมด และการกำหนดรหัสข้อมูล เพ่ือนำไปใช้ในการสร้างแฟ้มข้อมูลใน SPSS สำหรับบันทึกข้อมูล 
จากเครื่องมือที่เก็บรวบรวมมา 
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4. การออกแบบเครื่องมือรวบรวมข้อมูลเพื่อทำการบันทึกข้อมูลใน SPSS 

 ในที่นี้จะกล่าวถึงกรณีท่ีเครื่องมือที่ใช้ในการรวบรวมข้อมูล เป็นแบบสอบถาม หรือแบบสำรวจ 

การกำหนดตัวแปร การกำหนดรหัสสำหรับข้อมูล มักจะกระทำไปควบคู่กับการสร้างแบบสอบถาม โดยผู้สร้าง

แบบสอบถาม จะต้องพิจารณาถึงจำนวนตัวแปร ซึ่งคำถามในแบบสอบถาม 1 ข้อ จะนำมาสร้างเป็นตัวแปรได้ 

1 ตัว หรืออาจมากกว่านั้น ค่าของตัวแปรก็ คือ ค่าของข้อมูล สำหรับในกรณีข้อมูลเชิงกลุ่ม จะกำหนดรหัสให้

ข้อมูลเพ่ือความสะดวกในการบันทึกข้อมูลจากแบบสอบถาม  

 4.1 การจัดทำสมุดคู่มือกำหนดรหัส 

      สมุดคู่มือกำหนดรหัสจะมีไว้เพ่ือช่วยในการกำหนดชื่อตัวแปรเพื่อสร้างแฟ้มข้อมูลใน SPSS และ

ใช้ประกอบการบันทึกข้อมูลในสมุดคู่มือกำหนดรหัส ประกอบด้วย 

      1. ชื่อตัวแปร (Variable  name) หลักการกำหนดชื่อตัวแปร  ควรกำหนดเป็นตัวอักษร

ภาษาอังกฤษ  หรือตัวอักษรผสมกับตัวเลขรวมกันไม่เกิน 8 ตัวอักษร ชื่อตัวแปรที่กำหนดควรสื่อความหมาย  

เช่น  อายุ ใช้ชื่อตัวแปรว่า age การศึกษา ใช้ชื่อตัวแปรว่า edu 

      2. ชนิดของตัวแปร (Variable Type) ชนิดของตัวแปรที่นิยมกำหนดจะมีสองประเภท คือ ตัวแปร

ชนิดตัวอักษร (String) สามารถวิเคราะห์ค่าสถิติได้เพียงบางค่า เช่น ความถี่ ร้อยละ และตัวแปรชนิดตัวเลข 

(Numeric) สามารถวิเคราะห์ค่าสถิติได้ทุกค่า 

               3. คำอธิบายตัวแปร (Variable label) คือ คำอธิบายว่าตัวแปรนั้นแทนอะไรเพื่อให้สื่อความหมาย  

     4. ขนาดตัวแปร (Width) คือ จำนวนหลักของค่าตัวแปร 

     5. ค่าท่ีเป็นไปได้และคำอธิบายค่าตัวแปร (Value and Value label) จะกำหนดให้เฉพาะตัวแปร

ระดับ Nominal และ Ordinal เท่านั้น สำหรับตัวแปรที่อยู่ในระดับ Interval และ Ratio ไม่ต้องกำหนด 

 4.2 เทคนิคการกำหนดรหัส 

      คำถามปลายปิด  เป็นคำถามที่กำหนดคำตอบไว้ล่วงหน้าแน่นอนแล้ว  ผู้ตอบจะต้องเลือกตามที่

กำหนดไว้และสามารถลงรหัสได้ดังนี้ 

1. คำถามแบบให้เลือกตอบเพียงคำตอบเดียว ให้กำหนดตัวแปร 1 ตัวต่อคำถามหนึ่งข้อ   

         เช่น          เพศ            ( )  ชาย                    ( )  หญิง  

     การกำหนดรหัส 

no. Variable name Variable label width value Value label 

1 sex เพศ 1 1 

2 

9 

ชาย 

หญิง 

ไม่ตอบ 
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2. คำถามแบบให้เลือกตอบได้มากกว่า 1 คำตอบ  ให้กำหนดตัวแปรเท่ากับจำนวนตัวเลือกท่ีให้ตอบ 

    เช่น  ท่านรู้จักมหาวิทยาลัยราชภัฏบุรีรัมย์จากแหล่งใดบ้าง  (ตอบได้มากกว่า  1 ข้อ) 

            (  )  ทางทีวี 

        (  )  ทางสิ่งพิมพ์ เช่น หนังสือพิมพ์  วารสาร 

             (  )  เพ่ือน/ญาติ แนะนำ 

            (  )  สมุดโทรศัพท์ 

 การกำหนดรหัส 

no. Variable name Variable label width value Value label 

1 bru1 ทางทีวี 1 

0 

1 

ไม่เลือก 

เลือก 

2 bru2 ทางสิ่งพิมพ์ เช่น 

หนังสือพิมพ์ วารสาร 

1 

3 bru3 เพ่ือน/ญาติ แนะนำ 1 

4 bru4 สมุดโทรศัพท์ 1 

 

3. คำถามแบบให้เรียงลำดับ 

   เช่น   เหตผุลที่ท่านตัดสินใจศึกษาต่อโดยจัดลำดับความสำคัญมากที่สุดเป็น 1 ไปหาน้อยที่สุดเป็น 3 

     (  )  การทำงานในอนาคต 

     (  )  ความพร้อมทางการเงิน 

     (  )  ความพร้อมด้านเวลา 

การกำหนดรหัส 

no. Variable 

name 

Variable label width value Value label 

1 edu1 การทำงานในอนาคต 1 1 

2 

3 

สำคัญอันดับ 1 

สำคัญอันดับ 2 

สำคัญอันดับ 3 
2 edu2 ความพร้อมทางการเงิน 1 

3 edu3 ความพร้อมด้านเวลา 1 
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4. คำถามแบบมาตรประมาณค่า เช่น 

ความพึงพอใจในด้านต่างๆ 
พอใจอย่างยิ่ง 

(5) 

พอใจ 

(4) 

เฉยๆ 

(3) 

ไม่พอใจ 

(2) 

ไม่พอใจอย่างยิ่ง 

(1) 

1. การบริการด้านการจอง 

คำแนะนำ การติดต่อ 

          

2. คุณภาพและรสชาติอาหาร           

การกำหนดรหัส 

no. Variable name Variable label width value Value label 

1 U1 การบริการด้านการจอง 

คำแนะนำ การติดต่อ 

  

1 1 

2 

3 

4 

5 

9 

ไม่พอใจอย่างยิ่ง 

ไม่พอใจ 

เฉยๆ 

พอใจ 

พอใจอย่างยิ่ง 

ไม่ตอบ 

2 U2 คุณภาพและรสชาติอาหาร 1 

 

 คำถามปลายเปิด  เป็นคำถามที่เปิดโอกาสให้ผู้ตอบ ตอบได้อย่างอิสระ สำหรับข้อมูลที่เป็นข้อความ  

การให้รหัสจะทำได้หลังจากได้ข้อมูลมาแล้วจึงค่อยจัดกลุ่มคำตอบ  ส่วนข้อมูลที่เป็นตัวเลขก็กำหนดรหัสให้

เท่ากับค่าของข้อมูลนั้นได้เลย 

5. คำถามแบบให้เติมคำตอบ    

         เช่น    อายุ..................ปี 

  การกำหนดรหัส 

no. Variable name Variable label width value Value label 

1 age อายุ 2 ค่าจริง 

99 

... 

ไม่ตอบ 
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ตัวอย่างแบบสอบถาม 

                                                                                        เลขที่แบบสอบถาม.............. 

การเข้ารับการอบรมการวิเคราะห์ข้อมูลด้วยโปรแกรมสำเร็จรูป 

กรุณาทำเครื่องหมาย  ✓ หน้าตัวเลือกหรือคำตอบที่ตรงกับข้อเท็จจริง / ความเห็นของท่าน 

ตอนที่ 1 ข้อมูลส่วนบุคคล 

1.  เพศ                    หญิง               ชาย 

2.  ระดับการศึกษา      ต่ำกว่าปริญญาตรี    ปริญญาตรี           สูงกว่าปริญญาตรี 

3.  อายุ......................ปี  

4.  เหตุผลที่ท่านสมัครเข้ารับการอบรม (ตอบได้มากกว่า 1 ข้อ) 

    อยากมีความรู้เรื่องการวิจัย           นำความรู้ไปใช้ในการทำวิจัย 

    นำความรู้ไปเผยแพร่แก่ผู้ร่วมงาน          ปฏิบัติหน้าที่เก่ียวข้องกับงานวิจัย 

5.  คะแนนก่อนการฝึกอบรม...............................คะแนน 

6.  คะแนนหลังการฝึกอบรม................................คะแนน 

ตอนที่ 2 ความรู้เกี่ยวกับสถิติ 

จงวงกลมล้อมรอบตัวเลือกท่ีท่านเห็นว่าถูกต้องที่สุดเพียงตัวเลือกเดียว 

1.  ข้อใดเป็นตัวแปรประเภทจัดกลุ่ม 

 1)   เพศ             2)   อายุ  3)   เงินเดือน             4)   ส่วนสูง 

2.  สถิติในข้อใดเหมาะสมสำหรับวิเคราะห์ข้อมูลประเภทจัดกลุ่ม 

 1)   ค่าเฉลี่ย  2)   ร้อยละ  3)   พิสัย    4)   ส่วนเบี่ยงเบนมาตรฐาน 

3.  ถ้าต้องการเปรียบเทียบคะแนนเฉลี่ยหลังการฝึกอบรมของผู้เข้าอบรมระหว่างเพศหญิงกับเพศชาย  ควรใช้

สถิติในข้อใด 

 1)   t – test  Independent  Sample  2)   t – test  dependent  Sample 

 3)   - test              4)   ANOVA 

4.  ถ้าต้องการหาความสัมพันธ์ระหว่างคะแนนก่อนการอบรมกับคะแนนหลังการอบรมของผู้เข้าอบรมทั้งหมด

ควรใช้สถิติในข้อใด 

 1)   t – test        2)   ANOVA       3)  Pearson      4)   Rho 
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5.  ข้อมูลในข้อใดเหมาะสมที่จะทำตารางแจกแจงความถี่แบบสองทาง 

 1)   คะแนนหลังการอบรมกับเงินเดือน 

 2)   เพศกับระดับการศึกษา 

 3)   คะแนนก่อนการอบรมกับคะแนนหลังการอบรม 

 4)   เพศกับคะแนนก่อนการอบรม 

ตอนที่ 3  ความรู้ที่ได้รับ 

1.  จงจัดลำดับความรู้ที่ท่านได้รับจากการเข้ารับการอบรมเรื่องต่าง ๆ โดยเรียงลำดับจากมากไปหาน้อย 

 ลำดับที่   (   )   การเขียนโครงร่างการวิจัย 

 ลำดับที่   (   )   การออกแบบการวิจัย 

 ลำดับที่   (   )   การสร้างเครื่องมือ 

 ลำดับที่   (   )   การวิเคราะห์ข้อมูล 

 ลำดับที่   (   )   การเขียนรายงานการวิจัย 

ตอนที่ 4 การนำความรู้ไปใช้ 

ท่านสามารถนำความรู้ในหัวข้อต่อไปนี้ไปใช้ประโยชน์ได้มากน้อยเพียงใด 

รายการ 
มากที่สุด 

(5) 

มาก 

(4) 

ปานกลาง 

(3) 

น้อย 

(2) 

น้อยท่ีสุด 

(1) 

1. การเขียนโครงร่างการวิจัย           

2. การออกแบบการวิจัย           

3. การสร้างเครื่องมือ           

4. การวิเคราะห์ข้อมูล           

5. การเขียนรายงานการวิจัย           
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การกำหนดรหัสจากแบบสอบถาม (Code Book) 

no. Variable name Variable label width value Value label 

1 id เลขที่แบบสอบถาม 3 ค่าจริง ................... 

2 sex เพศ 1 1 

2 

9 

ชาย 

หญิง 

ไม่ตอบ 

3 age อายุ 2 ค่าจริง 

99 

..................... 

ไม่ตอบ 

4 edu ระดับการศึกษา 1 1 

2 

3 

9 

ต่ำกว่าปริญญาตรี 

ปริญญาตรี 

สูงกว่าปริญญาตรี 

ไม่ตอบ 

5 reason 1 อยากมีความรู้ 

1 
0 

1 

ไม่เลือก 

เลือก 

6 reason 2 นำความรู้ไปทำวิจัย 

7 reason 3 นำความรู้ไปเผยแพร่ 

8 reason 4 ปฏิบัติหน้าที่ท่ีเกี่ยวข้อง 

9 pre คะแนนก่อนการอบรม 
2 

ค่าจริง 

99 

................... 

ไม่ตอบ 10 post คะแนนหลังการอบรม 

11 i1 ข้อที่ 1 

1 

1 

2 

3 

4 

9 

ตัวเลือกที่ 1 

ตัวเลือกที่ 2 

ตัวเลือกที่ 3 

ตัวเลือกที่ 4 

ไม่ตอบ 

12 i2 ข้อที่ 2 

13 i3 ข้อที่ 3 

14 i4 ข้อที่ 4 

15 title 1 การเขียนโครงร่างการวิจัย 

1 

1 

2 

3 

4 

5 

ได้รับความรู้มากท่ีสุด 

ได้รับความรู้มาก 

ได้รับความรู้ปานกลาง 

ได้รับความรู้น้อย 

ได้รับความรู้น้อยที่สุด 

16 title 2 การออกแบบการวิจัย 

17 title 3 การสร้างเครื่องมือ 

18 title 4 การวิเคราะห์ข้อมูล 

19 title 5 การเขียนรายงานการวิจัย 
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5. การดำเนินการกับข้อมูล 
 5.1 การเปลี่ยนค่าตัวแปร (Recode)  

      การเปลี่ยนค่าของข้อมูลสำหรับตัวแปรใด ๆ โดยอาจจะเป็นการเปลี่ยนค่าใด ๆ ค่าหนึ่ง เป็นค่า
ใหม่หรือเปลี่ยนจากค่าที่ต่อเนื่องกันเป็นค่าเดียว สามารถทำได้ 2 ลักษณะ คือ  

       คำสั่ง Recode into Same Variables เป็นการเปลี่ยนค่าตัวแปรโดยการแทนที่ตัวแปรเดิม 
      คำสั่ง Recode into Different Variables เป็นการเปลี่ยนค่าตัวแปรโดยสร้างตัวแปรใหม่ 

 
 

 
 
 

 

no. Variable 

name 

Variable label width value Value label 

20 apply 1 การเขียนโครงร่างการวิจัย 

1 

1 

2 

3 

4 

5 

ใช้ประโยชน์น้อยที่สุด 

ใช้ประโยชน์น้อย 

ใช้ประโยชน์ปานกลาง 

ใช้ประโยชน์มาก 

ใช้ประโยชน์มากที่สุด 

21 apply 2 การออกแบบการวิจัย 

22 apply 3 การสร้างเครื่องมือ 

23 apply 4 การวิเคราะห์ข้อมูล 

24 apply 5 การเขียนรายงานการวิจัย 
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1. การเปลี่ยนค่าในตัวแปรเดิม (Transform => Recode into Same Variables…)  

 
 

 1. เลือกตัวแปร ที่ต้องการเปลี่ยนค่าจากช่องหมายเลข ‘1’ มาท่ีช่อง ‘2’ หรือ Numeric Variable: 

 2. เลือกคำสั่ง Old and New Values… จะปรากฏดังรูปขวามือ  

 3. กำหนดค่าท่ีต้องการเปลี่ยนในส่วน Old Value และกำหนดค่าใหม่ที่ต้องการแทนค่าเดิมในส่วน 

New Value หลังจากนั้นเลือก Add จะปรากฏค่าท่ีเปลี่ยนในช่อง Old => New 

 4. คลิก Continue จะกลับมาแสดงหน้าจอ Recode into Same Variables (หน้าจอซ้ายมือ) ถ้า

ต้องการเปลี่ยนค่าของข้อมูลบางชุดให้กด If… เพ่ือกำหนดเงื่อนไขในการเลือกชุดข้อมูลที่จะนำมาเปลี่ยนค่า 

 5. คลิก OK ค่าของตัวแปรที่ถูกเลือกจะเปลี่ยนเป็นค่าใหม่ทันที 

2. การเปลี่ยนค่าและสร้างเป็นตัวแปรใหม่ (Transform => Recode into Different Variables…)  
     

 

1 2 
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 1. เลือกตัวแปรที่ต้องการเปลี่ยนค่าจากกล่องซ้ายมือ มาไว้ที่ช่อง Numeric Variable => Output 
Variable :  
 2. ตั้งชื่อตัวแปรใหม่ที่ช่อง Output Variable ที่ช่อง Name: หลังจากนั้นเลือกปุ่ม Old and New 
Values… โดยให้ ดำเนินการเช่นเดียวกับการเปลี่ยนค่าในตัวแปรเดิม (into Same Variable)  
 

ตัวอย่าง จากแบบสอบถาม 

 

1.  เพศ                    หญิง               ชาย 

2.  ระดับการศึกษา      ต่ำกว่าปริญญาตรี    ปริญญาตรี           สูงกว่าปริญญาตรี 

3.  อายุ......................ปี  

4.  คะแนนก่อนการฝึกอบรม...............................คะแนน 

5.  คะแนนหลังการฝึกอบรม................................คะแนน 

 

เก็บข้อมูลจากตัวอย่าง 15 อย่างได้ข้อมูลดังนี้ 

เพศ ระดับการศึกษา อายุ คะแนนก่อนฝึก คะแนนหลังฝึก 
1 1 23 11 15 
1 2 25 9 13 
2 2 29 5 10 
2 2 37 8 16 
2 2 40 6 9 
1 2 32 4 8 
1 1 35 13 17 
2 1 29 9 12 
1 1 30 14 19 
2 3 45 8 15 
1 2 50 10 13 
1 3 26 9 12 
2 1 33 10 18 
2 2 41 7 12 
2 3 32 8 15 

 

สร้างข้อมูลดังกล่าวในโปรแกรมสำเร็จรูปทางสถิติ  จะได้ดังภาพต่อไปนี้ 
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 จากแฟ้มข้อมูลข้างต้น ตัวแปร age ข้อมูลเป็นข้อมูลเชิงปริมาณ ต้องการเปลี่ยนเป็นข้อมูลเชิงกลุ่ม 

โดยตั้งชื่อตัวแปรใหม่เป็น age_new และค่าของตัวแปรเป็นดังนี้ 

 1 หมายถึง อายุน้อยกว่าถึง 28 ปี 

 2 หมายถึง อายุ 28 – 37 ปี 

 3 หมายถึง อายุ 38 – 47 ปี 

 4 หมายถึง อายุ 48 ปีขึ้นไป 

ขั้นตอนการใช้คำสั่ง Recode into Different Variables มีดังนี้ 

1. เลือก Transform => Recode into Different Variables… ดังรูป 
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2. จะปรากฏหน้าต่าง Recode into Different Variables 

 
 

➢ ทำการเลือกตัวแปรอายุ (age) ไว้ที่ช่อง Numeric Variable => Output Variable แลว้ตั้งชื่อตัวแปร

ใหม ่(age_new) ในช่อง Name พร้อมคำอธิบายในช่อง Label จากนั้นคลิก Change แล้ว

เครื่องหมาย ? จะเปลี่ยนเป็นตัวแปรใหม่ที่เรากำหนด 

➢ คลิก Old and New Values… แล้วกำหนดช่วงของอายุ พร้อมทั้งค่าใหม่  

➢ คลิก Add จนครบตามจำนวนกลุ่มที่ตั้งไว้ ดังภาพ 

 
 

➢ คลิก Continue แล้วคลิก OK จะกลับมาสู่หน้า Data view จะพบไฟล์ข้อมูลที่สร้างขึ้นมาใหม่เป็นตัว

แปรที่ชื่อว่า age_new  ดังภาพ 



17 
 

 

 

 หากเราต้องการเปลี่ยนค่าตัวแปร age โดยกำหนดเป็นช่วงทับตัวแปรเดิม ซึ่งค่าของตัวแปรเป็นดังนี้ 

  1 หมายถึง อายุน้อยกว่าถึง 28 ปี 

  2 หมายถึง อายุ 28 – 37 ปี 

  3 หมายถึง อายุ 38 – 47 ปี 

  4 หมายถึง อายุ 48 ปีขึ้นไป 

ขั้นตอนการใช้คาสั่ง Recode into Same Variables มีดังนี ้

 1. เลือก Transform => Recode into Same Variables… ดังรูป 
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 2. จะปรากฏหน้าต่าง Recode into Same Variables 

 
 

➢ ทำการเลือกตัวแปรอายุ (age) แล้วคลิก Old and New Values…  และกำหนดช่วงของข้อมูล  

➢ คลิก Add จนครบตามจำนวนกลุ่มที่ตั้งไว้ ดังภาพ 

 

➢ คลิก Continue แล้วคลิก OK จะกลับมาสู่หน้า Data view จะพบไฟล์ข้อมูลเดิมจะถูกค่าใหม่ทับลง

ไป ดังภาพ 

 



19 
 

 5.2 การสร้างตัวแปรใหม่จากการคำนวณและเงื่อนไข (Compute)  
 เป็นการสร้างตัวแปรใหม่ด้วยการคำนวณทางคณิตศาสตร์ มีข้ันตอนดังนี้  

   1. เลือก Transform => Compute Variable… จะปรากฏหน้าจอดังนี้  

 
 

  2. จะปรากฏหน้าต่าง Compute Variable ดังภาพ 

 

         ชื่อตัวแปรใหม่ 
     กำหนดการคำนวณ  
 

 
 

 

 

เลือกฟังก์ชัน 
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 5.3 การเลือกบางส่วนของแฟ้มข้อมูล (Select Cases) 

      คำสั่ง Select Cases เป็นการเลือกวิเคราะห์เพียงบางส่วนของข้อมูลเท่านั้น ไม่ได้เลือกมา

วิเคราะห์ทั้งหมด  

ขั้นตอนการใช้คำสั่ง Select Cases… มีดังนี ้

 1. เลือก Data => Select case… จะปรากฏหน้าต่าง Select case ดังภาพ 

 

แล้วเลือก If and condition is satisfied และคลิก If… 

 2. ใส่เงื่อนไขท่ีต้องการ และคลิก continue ดังภาพ 
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 5.4 การเรียงลำดับข้อมูล (Sort Cases)  

      เป็นคำสั่งในการเรียงลำดับ case ตามตัวแปรใดตัวแปรหนึ่ง เช่น จัดเรียงข้อมูลตามคะแนน 

จัดเรียงข้อมูลตามชื่อ เป็นต้น ดังนั้นก็จะมีการสลับที่ของ case ตามลำดับที่จัดเรียง 

ขั้นตอนการใช้คำสั่ง Sort Cases… มีดังนี ้

 1. เลือก Data => Sort Case…. จะปรากฏหน้าจอ ดังนี้  

 
         

  2. เลือกตัวแปรอย่างน้อย 1 ตัวลงในช่อง Sort by (ในช่องนี้สามารถเลือกตัวแปรที่ต้องการจัดอันดับ

ได้มากกว่า 1 ตัวแปร) ส่วนลักษณะของการเรียง เลือกกำหนดจากช่อง Sort Order โดยที่ Ascending เป็น

การเรียงจากค่าน้อยไปมาก และ Descending เรียงจากค่ามากไปน้อย   

 
 

 3. คลิก OK จะพบไฟล์ข้อมูลจะจัดลำดับข้อมูลใหม่ โดยเรียงจากลำดับอายุที่น้อยไปหามาก 
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การใช้สถิติเชิงพรรณนาร่วมกับโปรแกรม SPSS for windows 
 จากข้อมูลที่นักวิจัยเก็บรวบรวมได้ซึ่งอาจเป็นข้อมูลเชิงคุณภาพหรือข้อมูลเชิงปริมาณที่นักวิจัย

ต้องการสรุปเฉพาะของข้อมูลที่เก็บรวบรวมมาได้  ซึ่งไม่สามารถอ้างถึงลักษณะของประชากรได้นั้น เราจะต้อง

ใช้สถิติในส่วนที่เรียกว่า สถิติพรรณนา โดยผลการวิเคราะห์จะอยู่ในรูปตาราง แผนภูมิ หรือแผนภาพ ค่ากลาง

หรือการวัดแนวโน้มเข้าสู่ส่วนกลาง และการวัดการกระจาย ทั้งนี้ขึ้นอยู่กับลักษณะของข้อมูล 

 1. คำสั่ง Frequencies 

      เป็นคำสั่งการวิเคราะห์ข้อมูลเชิงกลุ่มหรือข้อมูลเชิงปริมาณ แต่จะเหมาะสมกับการใช้กับข้อมูลเชิง

กลุ่มมากกว่า คำสั่ง Frequencies จะคำนวณค่าต่าง ๆ ดังนี้ 

       1.1 ความถี่ เปอร์เซ็นต์ และเปอร์เซ็นต์สะสม สำหรับทั้งข้อมูลเชิงกลุ่มและข้อมูลเชิงปริมาณ 

       1.2 คำนวณค่าสถิติ เช่น ค่าเฉลี่ย ค่ามัธยฐาน ค่าเบี่ยงเบนมาตรฐาน ค่าแปรปรวน ค่าควอไทล์ 

และค่าเปอร์เซ็นต์ไทล์ สำหรับข้อมูลเชิงปริมาณ 

       1.3 แสดงกราฟแท่ง และกราฟวงกลม สำหรับข้อมูลเชิงกลุ่ม และแสดง Histogram สำหรับ

ข้อมูลเชิงปริมาณ 

ตัวอย่างข้อมูลเชิงกลุ่ม จากแฟ้มข้อมูล Ex 1 ต้องการดูร้อยละของคะแนนก่อนการฝึกอบรม พร้อมทั้งแสดง

วงกลม สามารถทำได้โดยใช้คำสั่งใน Frequencies 

ขั้นตอนการใช้คำสั่ง Frequencies มีดังนี ้

 1. เลือก Analyze => Descriptive Statistics => Frequencies… จะปรากฏหน้าต่าง

Frequencies 

 2. ทำการเลือกคะแนนก่อนการฝึกอบรม คลิก Charts… และเลือก Pie charts ดังภาพ 
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3. โปรแกรมแสดงผลลัพธ์หน้าต่าง output ดังภาพ 
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ตัวอย่างข้อมูลเชิงปริมาณ จากแฟ้มข้อมูล Ex 1 ต้องการหาอายุเฉลี่ย อายุมาตรฐาน อายุส่วนใหญ่ อายุสูงสุด 
อายุต่ำสุด พิสัยของอายุ และเปอร์เซ็นต์ไทล์ที่ 50 โดยใช้คำสั่ง Frequencies  
ขั้นตอนการใช้คำสั่ง Frequencies มีดังนี ้ 
 1. เลือก Analyze => Descriptive Statistics => Frequencies…  
 2. ทำการเลือกตัวแปรอายุเข้าไป คลิก Statistics… และเลือก Mean, Median, Mode, Percentile: 
50, Minimum, Maximum และ Range แล้วคลิก Continue และคลิก ดังภาพ 

  
 

     3. ผลลัพธ์ที่ได้จากการวิเคราะห์ ดังนี้ 
Statistics 

อาย ุ  

N 
Valid 15 

Missing 0 

Mean 33.80 

Median 32.00 

Mode 29a 

Range 27 

Minimum 23 

Maximum 50 

Percentiles 50 32.00 

a. Multiple modes exist. The smallest value is shown 

 คำอธิบายผลลัพธ์ในตาราง 

 คือ ผลลัพธ์การวิเคราะห์ของตัวแปรเชิงปริมาณ : อายุ ซึ่งพบว่าชุดข้อมูลที่สมบูรณ์ (Valid) จำนวน 

15 ชุด และพบว่าไม่มีชุดข้อมูลที่สูญหาย (Missing) 

 โดยการสำรวจจากจำนวนผู้ตอบ 15 คน จะได้ว่า ค่าเฉลี่ย มัธยฐาน ฐานนิยม พิสัย ค่าน้อยที่สุด ค่า

มากที่สุดของอายุ เท่ากับ 33.80, 32, 29, 27, 23 และ 50 ตามลำดับ และเปอร์เซ็นไทล์ที่ 50 ของอายุ คือ 32 
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 2. คำสั่ง Descriptive  
     เป็นคำสั่งวิเคราะห์ข้อมูลเชิงปริมาณ สามารถใช้คำสั่งนี้ประมวลผลตัวแปรเชิงปริมาณหลายตัว ซ่ึง
จะแสดงผลลัพธ์เรียงตามลำดับตัวแปรที่ถูกเลือก  
ตัวอย่าง จากแฟ้มข้อมูล Ex 1 ต้องการหาอายุเฉลี่ย อายุเบี่ยงเบนมาตรฐาน อายุสูงสุด และอายุต่ำสุด โดยใช้
คำสั่ง Descriptive  
ขั้นตอนการใช้คำสั่ง Descriptive  
 1. เลือก Analyze => Descriptive Statistics => Descriptives…  
     2. ทำการเลือกตัวแปรอายุเข้าไป คลิก Options… และเลือก Mean, Std. deviation, Minimum, 

Maximum และ Variance แล้วคลิก Continue และคลิก OK ดังภาพ 
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  3. ผลลัพธ์ที่ได้จากการวิเคราะห์ ดังนี้ 
Descriptive Statistics 

 N Minimum Maximum Mean Std. Deviation Variance 

อาย ุ 15 23 50 33.80 7.618 58.029 

Valid N (listwise) 15      

 

     คำอธิบายของผลลัพธ์ในตาราง  
 1. มีจำนวนผู้ตอบ 15 คน  
  2. อายุน้อยที่สุดของผู้ตอบ 23 ปี 

  3. อายุสูงที่สุดของผู้ตอบ 50 ปี 

  4. อายุเฉลี่ยของผู้ตอบ 33.80 ปี 

  5. ค่าส่วนเบี่ยงเบนมาตรฐานของอายุผู้ตอบ คือ 7.618 

  6. ค่าความแปรปรวนของอายุผู้ตอบ คือ 58.029 

 
 3. คำสั่ง Means  
        เป็นคำสั่งที่ใช้ในการหาค่าเฉลี่ยและค่าสถิติต่าง ๆ ของตัวแปรเชิงปริมาณ จำแนกตามค่าของตัว
แปรเชิงกลุ่ม เช่น คะแนนหลังการฝึกอบรม จำแนกตามระดับการศึกษา เป็นต้น  
ตัวอย่าง จากแฟ้มข้อมูล Ex 1 ต้องการหาคะแนนหลังการฝึกอบรม จำแนกตามระดับการศึกษา 
ขั้นตอนการใช้คำสั่ง Means  
 1. เลือก Analyze => Compare Means => Means…  
     2. เลือกตัวแปรคะแนนหลังการฝึกอบรม ลงใน Dependent List และเลือกตัวแปรระดับการศึกษา 

ลงใน Independent List และคลิก Options ดังภาพ 

 
 

  3. เลือกค่าสถิติสถิติท่ีต้องการ ในที่นี้ขอเลือก Mean, Std. Deviation, Number of case, 

Variance, Minimum, Maximum แล้วคลิก Continue 

1 2 3 4 5 
6 
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  4. คลิก OK จะได้ผลลัพธ์ในการวิเคราะห์ ดังภาพ 
Report 

คะแนนก่อนฝึก   

ระดับการศึกษา Mean N Std. Deviation Variance Minimum Maximum 

ต่ำกวา่ปริญญาตร ี 11.40 5 2.074 4.300 9 14 
ปริญญาตร ี 7.00 7 2.160 4.667 4 10 
สูงกว่าปริญญาตร ี 8.33 3 .577 .333 8 9 
Total 8.73 15 2.712 7.352 4 14 
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แบบฝึกปฏิบัตกิารใช้โปรแกรมสำเร็จรูปทางสถิติเบื้องต้น (SPSS) 
********************************************************* 

แบบสอบถาม 
พฤติกรรมการออกกำลังกายของบุคลากร กรมควบคุมโรค กระทรวงสาธารณสุข 

ให้นักศึกษาสร้างแฟ้มข้อมูลจากแบบสอบถามต่อไปนี้ 
ข้อมูลส่วนบุคคลทั่วไป  
คำชี้แจง โปรดทำเครื่องหมาย   ลงใน  หรือเติมข้อความลงในช่องว่างตรงตามความเป็นจริง  
 1. เพศ       ชาย    หญิง 
 2. อายุ…………ปี   
 3. ระดับการศึกษาสูงสุด  
    ต่ำกว่าปริญญาตรี     ปริญญาตรี  
    ปริญญาโท      ปริญญาเอก 
 4. รายได…้………………..บาทตอ่เดือน  
 5. ท่านมีโรคประจำตัวหรือไม่  
    ไม่มี     มีโรคประจำตัว  
 6. ปัจจุบันท่านออกกำลังกายเพ่ือสุขภาพด้วยวิธีใด (ตอบได้มากกว่า 1 ข้อ)  
    เดิน     วิ่งเหยาะ ๆ     เต้นแอโรบิค  
    ไท้เก๊ก      ปั่นจักรยานอยู่กับที่   
เก็บข้อมูลจากตัวอย่างจำนวน 30 ตัวอย่างได้ข้อมูลดังนี้ 

ลำดับ เพศ อาย ุ
ระดับการศึกษา

สูงสุด 
รายได้ 

โรค
ประจำตัว 

เดิน วิ่งเหยาะๆ 
เต้นแอ 
โรบิค 

ไท้
เก๊ก 

ปั่นจักรยาน
อยู่กับที ่

1 1 23 2 21,000 1 0 1 0 1 1 
2 2 45 1 17,000 1 0 0 1 0 0 
3 2 35 2 18,030 2 1 1 0 0 1 
4 1 52 2 21,500 1 0 1 1 0 0 
5 1 27 1 13,000 2 1 0 1 1 0 
6 2 42 3 35,000 2 1 0 0 1 0 
7 1 38 4 42,000 1 0 1 0 0 1 
8 2 29 2 19,200 1 0 1 1 0 0 
9 2 30 3 31,000 2 0 0 1 0 0 
10 1 41 2 14,000 1 0 0 0 0 1 
11 1 48 2 21,200 1 0 1 1 0 1 
12 2 32 2 18,300 1 1 1 0 0 1 
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ลำดับ เพศ อาย ุ
ระดับการศึกษา

สูงสุด 
รายได้ 

โรค
ประจำตัว 

เดิน วิ่งเหยาะๆ 
เต้นแอโร

บิค 
ไท้
เก๊ก 

ปั่นจักรยาน
อยู่กับที ่

13 1 26 2 20,000 1 0 1 1 1 0 
14 1 33 2 24,000 1 0 0 0 1 1 
15 2 51 2 27,500 1 1 0 1 1 0 
16 2 28 1 15,000 2 0 1 0 0 1 
17 1 39 3 31,200 1 1 1 1 0 0 
18 1 43 2 28,000 1 0 0 1 0 1 
19 2 47 1 16,000 1 1 1 0 1 0 
20 2 35 2 17,000 1 1 0 0 0 1 
21 1 28 1 15,000 2 0 1 1 0 0 
22 2 49 2 24,000 2 1 1 1 0 1 
23 1 24 2 18,000 2 0 1 0 0 1 
24 2 52 3 37,000 1 1 1 0 0 0 
25 2 45 2 22,100 2 0 1 1 1 1 
26 1 30 1 17,900 1 0 1 0 0 1 
27 2 39 2 25,430 2 1 0 0 1 1 
28 1 27 1 19,000 1 0 1 0 0 1 
29 1 46 3 35,200 1 1 1 1 0 0 
30 2 49 4 42,500 1 1 0 1 1 0 

 

1. ให้เปลี่ยนค่าตัวแปรอายุ (age) โดยกำหนดค่าของตัวแปรเป็นดังนี้ 

  อายุน้อยกว่าถึง 28 ปี  แทน 1 

  อายุ 29 – 39 ปี        แทน 2  

  อายุ 40 – 49 ปี        แทน 3  

  อายุ 50 ปีขึ้นไป        แทน 4 

2. ให้เรียงลำดับข้อมูลของรายได้ จากรายได้มากไปหารายได้น้อย 

3. ให้วิเคราะห์ข้อมูลกรณีท่ีผู้ตอบมีระดับการศึกษาปริญญาตรีและมีรายได้มากกว่า 20,000 บาท 

4. ให้ใช้คำสั่ง Frequencies ในการวิเคราะห์ข้อมูลสถิติพรรณนา (ค่าเฉลี่ย ความแปรปรวน ค่าเบี่ยงเบน

มาตรฐาน ค่าสูงสุด ค่าต่ำสุด) ของตัวแปรรายได้ และอธิบายผลลัพธ์พร้อมทั้งแสดงแผนภูมิแท่งและ 

ฮิสโทแกรม 


